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THE INFORMATION CONTAINED IN THIS DOCUMENT IS PROVIDED ON AN “AS IS” BASIS.  

Oak Micros does not warrant merchantability for any purpose and shall not be liable for any direct, 
indirect, incidental, special, exemplary, or consequential damages of any kind, however incurred, 
through the use of our products. 

 

The Oak Micros home page can be found at http://oakmicros.com 

 

 

Document History 

Version 1.0 December 20, 2008 First Publication. 

Version 1.0.1 January 7, 2009 Minor corrections.



Oak Micros              User Guide for the Sump Logic Analyzer and omla32 Interface Card 

Version 1.0.1     January 7, 2009 Page 3 of 28  

 

Contents 

1 Introduction___________________________________________________________________ 5 

2 Getting Started_________________________________________________________________ 6 

2.1 Download the Logic Analyzer into the FPGA Development Board ________________________ 6 
2.1.1 Connecting the Diligent Development Board__________________________________________________6 
2.1.2 Installing Xilinx ISE Development Software __________________________________________________6 
2.1.3 Installing the Logic Analyzer Software ______________________________________________________8 
2.1.4 Programming the FPGA Development Board _________________________________________________8 

2.2 Setting up the Java User Interface _________________________________________________ 10 
2.2.1 Download Java ________________________________________________________________________10 
2.2.2 Starting the Java User Interface ___________________________________________________________10 

2.3 Connecting to the Circuit under Test _______________________________________________ 11 

2.4 Capturing Traces using the Logic Analyzer__________________________________________ 13 
2.4.1 Serial Port Configuration ________________________________________________________________13 
2.4.2 Configuration for Sampling and Channels ___________________________________________________15 
2.4.3 Collecting Data from the Logic Analyzer____________________________________________________16 

3 Advanced Features ____________________________________________________________ 18 

3.1 Using Triggers __________________________________________________________________ 18 
3.1.1 Simple Trigger ________________________________________________________________________18 
3.1.2 Complex Trigger_______________________________________________________________________20 

3.2 Protocol Analysis________________________________________________________________ 20 
3.2.1 I2C _________________________________________________________________________________20 
3.2.2 SPI _________________________________________________________________________________22 

3.3 Using the External Clock Input ____________________________________________________ 23 

3.4 Logic Analyzer ISE Project _______________________________________________________ 25 

4 Getting Support _______________________________________________________________ 27 

Appendix A: Schematic for omla32 ___________________________________________________ 28 

 



Oak Micros              User Guide for the Sump Logic Analyzer and omla32 Interface Card 

Version 1.0.1     January 7, 2009 Page 4 of 28  

 

Figures 
Figure 1: Sample Xilinx Product Entitlement List________________________________________ 7 
Figure 2: Example Xilinx webpage for downloading of ISE Development Software _____________ 7 
Figure 3: Choosing the iMPACT Project File___________________________________________ 8 
Figure 4: iMPACT Main Window and Context Menu _____________________________________ 9 
Figure 5: Example Progress Dialog for FPGA Programming ______________________________ 9 
Figure 6: Example Success Message _________________________________________________ 10 
Figure 7: Java User Interface Main Window __________________________________________ 11 
Figure 8: Connecting the omla32 to the Spartan3 FPGA Development Board ________________ 12 
Figure 9: Inputs on the omla32 Interface Card_________________________________________ 12 
Figure 10: Different Connectors to the omla32 Interface Card ___________________________ 13 
Figure 11: Logic Analyzer Capture Dialog___________________________________________ 14 
Figure 12: Analyzer Serial Port Selection____________________________________________ 14 
Figure 13: Logic Analyzer Configuration for 200MHz Sampling Rate______________________ 15 
Figure 14: Sample Uploading in Progress ___________________________________________ 16 
Figure 15: Example Data Capture _________________________________________________ 17 
Figure 16: Diagram Settings Dialog ________________________________________________ 17 
Figure 17: Trigger Controls ______________________________________________________ 18 
Figure 18: Sample Trace Timescale with Trigger Point _________________________________ 18 
Figure 19: Simple Trigger Configuration ____________________________________________ 18 
Figure 20: Example Parallel Mode Trigger __________________________________________ 19 
Figure 21: Example RS232 Character_______________________________________________ 19 
Figure 22: Example Serial Mode Trigger ____________________________________________ 19 
Figure 23: Example Trigger for I2C ________________________________________________ 20 
Figure 24: Example Data Capture for I2C ___________________________________________ 21 
Figure 25: Example I2C Analysis __________________________________________________ 21 
Figure 26: Example I2C Communication between Master and Slave_______________________ 22 
Figure 27: Example Data Capture for SPI Protocol____________________________________ 22 
Figure 28: Example SPI Communication between Master and Slave _______________________ 23 
Figure 29: Choosing the Sampling Clock ____________________________________________ 23 
Figure 30: Connecting an External Clock____________________________________________ 24 
Figure 31: Example Data Capture and IC2 Analysis using an External Clock _______________ 25 
Figure 32: Logic Analyzer Project in ISE 10.1 Project Navgiator _________________________ 25 
Figure 33: Using the iMPACT tool inside the Xilinx ISE Project Navigator _________________ 26 
Figure 34: omla32 Interface Card Schematic _________________________________________ 28 
 

 



Oak Micros              User Guide for the Sump Logic Analyzer and omla32 Interface Card 

Version 1.0.1     January 7, 2009 Page 5 of 28  

 

1 Introduction 

This document is a user guide for the FPGA-based logic analyzer written by Michael “Sump” Poppitz 
– see http://www.sump.org/projects/analyzer. This document also describes using the Oak Micros 
omla32 interface card for this logic analyzer. 

The logic analyzer is based on the Xilinx Spartan 3 development board manufactured by Digilent 
Incorporated. This board together with a 5V power supply and JTAG programming cable can be 
purchased from Digilent – see http://digilentinc.com/Products/Detail.cfm?Prod=S3BOARD. The logic 
analyzer only requires just over half of the capacity of the 200K gate version of the Spartan 3 FPGA. 

The omla32 interface card protects the FPGA by buffering and providing voltage level conversion for 
the 32 input channels and optionally one external clock source. The 2.4 inch by 2.8 inch interface card 
plugs into the “B1” expansion connector of the Spartan 3 development board and can be purchased 
from Oak Micros – see http://oakmicros.com/content/omla32-Logic-Analyzer-Interface-Card.html. As 
an option 10 color-coded female-to-female jumpers are available for connecting signals to the male 
headers on the interface card and circuit under test. 

The specifications for the logic analyzer combined with the omla32 interface card are as follows: 

· Sampled channels: 32 

· Timing mode sample rate: 32 channels at 10Hz to 100 MHz, 16 channels at 200 MHz 

· State analysis up to 50MHz using external clock 

· Sample buffer: 32 x 262144 (256K) samples 

· Up to 4 stage trigger with each stage on either serial data in a single channel or parallel data in 
multiple channels  

· Externally available sampling clock to drive add-ons (like ADCs) 

· Active noise filtering at sampling rates up to 100 MHz 

· Input voltage between –0.5V and 7V 

· Bus hold on data inputs eliminates external pullup or pulldown resistors 

· Connects via EIA232/RS232 to host PC (works with USB to serial adapters) with a maximum 
upload speed of 115,200 Baud. Upload time for 32 channels of 256K samples is 100 seconds. 

· Java based viewing software with I2C & SPI protocol analysis 

Section 2 of this manual explains how to get started with the logic analyzer. Section 3 describes some 
more advanced topics such as using the triggering and protocol analysis features of the Logic Analyzer. 
Appendix A shows the schematic for the omla32 interface card. 
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2 Getting Started 

This chapter explains how to get started with the FPGA-based logic analyzer. The other chapters in this 
manual should be consulted for more details on the hardware and support software. There are four 
stages to getting started with the logic analyzer: 

1. Download the logic analyzer into the FPGA development board 

2. Install and start the host PC Java user interface 

3. Connect the omla32 interface card to the circuit under test and the FPGA development board 

4. Use the Java user interface to capture traces and view results 

2.1 Download the Logic Analyzer into the FPGA Devel opment Board 

There are four steps to downloading the logic analyzer into the Diligent Spartan 3 FPGA development 
board as described in each of the sections below. 

2.1.1 Connecting the Diligent Development Board 

After unpacking the Xilinx FPGA development board, you need to connect the 5V power. Note that 
there is no power switch on the board and for safety reasons it is best to unplug and replug the power as 
necessary. The green power LED will light when powered has been applied. 

The development board comes with a JTAG cable that plugs into a PC parallel port. If you don’t have a 
parallel port, for example on a laptop computer, then you can purchase a USB JTAG cable from 
Diligent (http://digilentinc.com/Products/Detail.cfm?Prod=JTAG-USB). Make sure that you connect 
the JTAG cable with the correct orientation. The development board as shipped by Diligent is correctly 
configured for downloads from the PC i.e. the mode is set to 0 as the three mode jumpers are all closed. 

2.1.2 Installing Xilinx ISE Development Software 

The next step is to install the Xilinx ISE development software for either Windows or Linux. This 
software includes the iMPACT tool that allows you to perform file generation and to configure or 
program Xilinx FPGAs and PROMs. In particular we are going to use the tool to program the Logic 
Analyzer into the serial flash memory (PROM) associated with the Xilinx Spartan 3 FPGA. The 
PROM is programmed rather than the FPGA directly so that the programming is non-volatile (i.e. 
maintained through a power off/power on cycle). 

The free Xilinx development software (ISE WebPACK 10.1) is downloadable from the Xilinx website. 
After creating an account and logging on you should see your entitlement list similar to the following: 
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Figure 1:  Sample Xilinx Product Entitlement List 

Follow the prompts on the web pages to select ISE WebPACK 10.1 free download. This package is 
only 48M bytes in size but then downloads 2.3G bytes from the Xilinx website. Alternatively you can 
order a DVD from Xilinx. You should see a page similar to the following. Note that the registration ID 
has been blocked on this screen snapshot. 

 
Figure 2:  Example Xilinx webpage for downloading of ISE Development Software 

Execute the installation program and following the on screen prompts. There is a lot to install here so 
some patience is needed before everything has finished installing. 
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2.1.3 Installing the Logic Analyzer Software 

The base logic analyzer software is available from Michael Poppitz’s logic analyzer website: 
http://www.sump.org/projects/analyzer. However this software requires some changes in the FPGA 
logic analyzer before it can be built correctly by ISE and does not include the configuration files 
needed for downloading the logic analyzer into FPGA development board. 

A quick-start solution is available by downloading the logic analyzer ZIP file from Oak Micros website 
(see http://oakmicros.com/content/downloads/Download-document/Logic-Analyzer-Files.html). This 
package includes all of the required source and binary files in a 3M byte file in ZIP format. This format 
is used rather than the original bzipped tar file as it is easier to use for Windows based developers. A 
freeware Windows program for ZIP files is available from http://www.7-zip.org. Once downloaded, 
unzip the file contents into a directory. 

2.1.4 Programming the FPGA Development Board 

The zip file from Oak Micros contains everything needed to program the FPGA PROM. Start the 
iMPACT Xilinx GUI tool. On Windows it is available from the start menu in the Accessories subfolder 
of ISE 10.1. 

The iMPACT tool asks for the project file name using the following dialog. As shown the name of the 
project file is Logic_Analyzer.ipf. 

 
Figure 3:  Choosing the iMPACT Project File 

If this dialog is not shown, you can also open the project file using the “Open Project… (Ctrl-O)” menu 
item on the “File” menu. 

There are two main tabs in the iMPACT tool as shown in the screen shot on the next page. Select the 
“Boundary Scan” tab. Then right click on the xcf02s device (serial flash) and a context menu should 
appear. The FPGA board can be programmed using “Program” item from the context menu. 
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Figure 4:  iMPACT Main Window and Context Menu 

There will be a slight pause for a few seconds to erase the device and then you should see a 
progress dialog as shown below: 

 

Figure 5:  Example Progress Dialog for FPGA Programming 

Erasing, programming and verifying takes approximately 28 seconds and iMPACT shows the 
following success message in the Boundary Scan tab.  
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Figure 6:  Example Success Message 

You will need to consult the Xilinx documentation if there is a “Program Failed” error message. The 
usual causes are no power to the development board, bad parallel port connection to the host PC or the 
programming jumpers are set incorrectly. You can verify the connection by selecting “Get Device ID” 
from the context menu. 

It is also possible to use iMPACT from the command line using the –batch parameter. In batch mode 
the following commands can be used to program the flash memory: 

>loadprojectfile -file c:\fpga\Logic_Analyzer.ipf 
>setcable -port lpt1 
>program -p 2 -e –v 
>quit 
 

The JTAG cable is no longer needed at this point and can be disconnected from the development board. 

2.2 Setting up the Java User Interface 

There are two steps to setting up the host PC Java user interface for the logic analyzer as described in 
each of the sections below. 

2.2.1 Download Java 

Most PCs should already have a version of Java installed. This is easy to check by typing the following 
command, which displays the version of Java that is installed: 

java –version 

If this command does not work then you can download Java for your operating system from 
http://www.java.com/en/download/manual.jsp. Follow the install instructions on the webpage. 

Make a note of the directory where Java is installed or where it was installed into. This directory will 
be used in the next section. 

2.2.2 Starting the Java User Interface 

A pre-requisite for the Java user interface is the RXTXcomm package. The Windows version of this 
package is already included in the package from the Oak Micros website. You can also download it 
from the RXTX website: http://www.rxtx.org. 

If you know the directory where Java is installed then you can put the RXTXcomm.jar into the lib\ext 
subdirectory and start the Java user interface using the “run” Windows batch file or Linux shell script. 
If you do not know where Java is installed or want to use the RXTXcomm jar file without moving it, 
then you can use the “runit” Windows batch file to start the Java user interface. 
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The command line batch files take two optional parameters; the first is the project file and the second is 
the output data file. Typing –h as a parameter (or indeed anything that starts with a “-“) shows the 
invocation help text as follows: 

 
Sumps Logic Analyzer Client 
Copyright (C) 2006 Michael Poppitz 
This software is released under the GNU GPL. 
 
Usage: run [<project file>] [<data file>] 
 
        <project file> is a saved project with file  extension ".slp" 
        <data file> is saved data with file extensi on ".sla" 

The logic analyzer main window should now be displayed as shown below. I reduced the window size 
for purposes of taking the screen snapshot. 

 
Figure 7:  Java User Interface Main Window 

If you get the following error message then the RXTXcomm.jar is not available or cannot be located by 
Java. 

java.lang.reflect.InvocationTargetException 
        at java.awt.EventQueue.invokeAndWait(Unknow n Source) 
        at javax.swing.SwingUtilities.invokeAndWait (Unknown Source) 
        at org.sump.analyzer.Loader.main(Loader.jav a:94) 
Caused by: java.lang.NoClassDefFoundError: gnu/io/C ommPortIdentifier  

The following error message is caused by the rxtxSerial.dll not being in the DLL path on Windows. 

java.lang.reflect.InvocationTargetException 
        at java.awt.EventQueue.invokeAndWait(Unknow n Source) 
        at javax.swing.SwingUtilities.invokeAndWait (Unknown Source) 
        at org.sump.analyzer.Loader.main(Loader.jav a:94) 
Caused by: java.lang.UnsatisfiedLinkError: no rxtxS erial in java.library.path  

One problem is that the project file does not load correctly when specified on the command line. The 
workaround is to simply use the Project menu and open the project file after the main window is 
displayed. 

2.3 Connecting to the Circuit under Test 

The omla32 interface card provides buffering and voltage conversion for the logic analyzer inputs. The 
card plugs directly into the B1 connector on the Spartan3 FPGA development board as shown in the 
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picture below. The omla32 contains headers for each of the 32 logic analyzer inputs and for two clock 
sources. 

You should also connect a serial cable to the bottom 9-pin DSUB connector. Most USB to serial 
adapters should also work if you do not have a serial port on your PC. Do not yet connect power to the 
development board. 

 
Figure 8:  Connecting the omla32 to the Spartan3 FPGA Development Board 

The header in the middle of the omla32 interface card is probably the one you will use the most. Each 
of the inputs is numbered and interspersed with ground pins. You must also connect one or more of the 
ground pins to the circuit under test. This header is laid out to be pin compatible with Intronix logic 
analyzers. Note that input 6 is mislabeled as input 8. 

 
Figure 9:  Inputs on the omla32 Interface Card 
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The omla32 is optionally provided with 10 colored jumper wires that correspond to the resistor color 
codes. It is suggested that the gray and white are used for grounds and the remaining 8 colors (black, 
brown, red, orange, yellow, green, blue, purple) are used for channels 0 through 7. 

These jumpers can be used to connect to male headers on the circuit under test. Alternatively it may be 
better to use test clips or grabbers such as the XKM range manufactured by E-Z-Hook. You can also 
use IC clips such as the 3M test clips available from Digi-Key (search for “test clip”). 

The two headers to the right are laid out to be pin compatible with Agilent logic analyzers. The header 
labeled “odd” provides inputs 0 to 15 and the header labeled “even” provides inputs 16 to 31. The pins 
on the left side of each dual row are connected to ground. Note that at this time it is not possible to use 
Agilent probes with the omla32 interface card.  

At the bottom of each header is a small numeral “1” to indicate pin 1 of the header. It is possible to use 
inexpensive 40-way IDE cables with any of the three headers to provide a fast way of connecting 
multiple inputs at once.  IDE cables with a key at pin 20 cannot be used. There are numerous other 
ways of connecting to the input headers such as using an 8-way jumper cable. Here are some examples: 

 
Figure 10:  Different Connectors to the omla32 Interface Card 

You can now power up the circuit under test and then the Spartan3 development board. The segments 
of the 4 seven segment LEDs may be lit or dimly lit showing activity on one or more of the 32 input 
channels. 

2.4 Capturing Traces using the Logic Analyzer 

At this point the logic analyzer is powered on and connected to the host PC and the circuit under test. 
This section describes the three steps needed to capture traces using the Java user interface. 

2.4.1 Serial Port Configuration 

The serial port baud rate for uploading data is configured using SW0 and SW1 on the Spartan3 
development board. The LEDs LD3 and LD4 reflect the position of these switches. The default baud 
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rate between the logic analyzer and the host PC is 115,200. Below is a summary table for the different 
baud rates, switch settings and LEDs: 

Baud Rate SW0 SW1 LD3 LD4 

115,200 LO LO Off Off 

57,600 LO HI Off On 

38,400 HI LO On Off 

19,200 HI HI On On 

 

To configure and start a capture, select the “Capture…” menu item on the “Device” menu and the 
following dialog is displayed.  

 
Figure 11:  Logic Analyzer Capture Dialog 

The “Connection Settings” area is used to configure the host PC serial port and baud rate used to 
communicate with the Spartan3 development board. The analyzer port field specifies the name of the 
serial port (or virtual serial port if a USB to serial port converter is used). The screen capture below 
shows a selection list of 4 serial ports, 

 
Figure 12:  Analyzer Serial Port Selection 
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The port speed has one of four values depending on the positions of SW1 and SW0. The default is 
115,200 baud and the “LL” notation next to the baud rate indicates the positions of the switches. 

2.4.2 Configuration for Sampling and Channels 

The next section for the analyzer settings is the area that you will use the most. For simple traces you 
should select the default internal sampling clock. The sampling rate, which can vary between 10Hz and 
200 MHz, will depend on the inputs. A logic analyzer is of most value when looking at transitions on 
inputs and therefore the required sampling rate will depend on the frequency on these transitions. A 
good rule of thumb is that the sampling rate should be between 4 and 10 times the maximum frequency 
of transitions i.e. the over-sampling ratio should be between 4 and 10. The greater the over-sampling 
ratio, the more accurate the captured data represents the actual input signals. For example if the speed 
of the I2C serial bus is 400 KHz then the sampling rate should be set to 2 or 5 MHz. 

The recording size, which defaults to 2K (2048), is used to determine how much data is captured. For 
example at the default sampling rate of 100 MHz, a 2K recording size can only be used to capture at 
most 2.048 ms (2048 * 10 ns) of data. The maximum recording size of 256K samples gives 2.62 ms of 
data at 100 MHz. 

Note that the upload speed for 32 channels of 256K samples is around 100 seconds at 115,200 baud so 
large sample sizes should be used only when needed. It may also take some time to review samples this 
large. Traces this long may indicate that you should be using triggers to look for a specific pattern. See 
section 3.1 on page 18 for more details on using triggers. 

The four check boxes for channel groups can be used to restrict how many channels of data are 
collected and transmitted to the host PC. Channel group 0 refers to inputs 0 to 7; channel group 1 refers 
to inputs 8 to 15 and so on. Eliminating channel groups also improves the upload speed because less 
data is uploaded. 

It is possible to sample data at up to 200 MHz. Note that at this speed it is only possible to collect data 
on up to 16 channels. Channel groups 2 and 3 are automatically disabled when this sampling rate is 
selected. 

 
Figure 13:  Logic Analyzer Configuration for 200MHz Sampling Rate 
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The last option in the logic analyzer settings group is the noise filter, which is on by default. The noise 
filter is used to automatically discard transitions that occur in less than one sample period. Because of 
high frequency needed for noise detection, it is not available for a 200 MHz sampling rate as shown in 
the previous screen capture. 

2.4.3 Collecting Data from the Logic Analyzer 

Pressing the Capture button on the capture dialog initiates the sampling. The logic analyzer works by 
collecting the requisite number of samples at the given sampling rate for each of the channels. The 
sampling only starts when the trigger criteria are met. The sampled data is stored in RAM while it is 
being collected and then uploaded to the host PC. Here is an example of the capture dialog during a 
sample collection showing an upload in progress. 

 
Figure 14:  Sample Uploading in Progress 

Either reopening the Capture dialog and pressing the Capture button again or using “Repeat Capture” 
menu item from the Device menu repeats a data capture.  

After a capture is completed, the capture dialog is closed and the main window shows the sampled data 
in a waveform manner for each channel captured. If the trigger is never activated then the capture 
dialog stays open and it may be best to cancel the capture by closing the dialog. 

Below is an example screen shot for 8 input channels (0 to 7). The waveforms are produced by a 
microcontroller that turns on each I/O pin in turn and then turns off each I/O pin in the same order, 256 
times a second. The B0 line below shows the 8 bit port value changing as each I/O pin is turned on and 
then turned off resulting in the pattern 00, 01, 03, 07, 0f, 1f, 3f, 7f, ff etc. The S0 line shows an 
“oscilloscope” trace of the same 8-bit pattern as though it is converted to an analog value. 
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Figure 15:  Example Data Capture 

Along the top of the window is a time scale. This scale (and the scale of the window) can be altered 
using the 3 magnifying icons or the Zoom In, Zoom Out, and Default Zoom menu items on the 
“Diagram” menu.  You can measure the time and frequency of any part of the trace by clicking on a 
point and dragging the mouse to an end point. The bottom of the window shows the result by 
displaying the channel number, time offset, time difference and frequency. When the mouse button 
released this status display returns to just displaying the channel number and time offset for the given 
mouse position. 

The Labels menu item on the Diagram menu can be used to label each of the channels instead of just a 
simple number. The Diagram Settings menu item displays the dialog shown below. It allows you to 
decide which channel groups to display and for each group to also show the scope trace and byte value. 
Figure 16 shows the values used for the example data capture in figure 15. 

 
Figure 16:  Diagram Settings Dialog 
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3 Advanced Features 

This chapter describes some more advanced features of the Spartan3 FPGA logic analyzer including 
using triggers, protocol analysis, external clocks, and how to rebuild the logic analyzer source code. 

3.1 Using Triggers 

The logic analyzer supports 3 types of triggering; none, simple and complex. The default is none as 
used in chapter 2. Simple triggering is a single stage trigger and complex triggering is a multi-stage 
trigger up to 4 stages. 

Simple or complex triggering is turned on using the triggering enable checkbox as shown in the 
screenshot below. The “Type” dropdown list is now enabled to choose either simple or complex 
triggering. 

 
Figure 17:  Trigger Controls 

The before/after ratio controls how much of the trace is shown before the trigger point and how much 
afterwards. There are 5 before/after ratios available; 100/0, 75/25, 50/50, 25/75, and 0/100. The default 
is 50/50 which means half of the trace data is shown before the trigger point and half afterwards. The 
timescale is adjusted to show the trigger point as 0 seconds with a green vertical line. Trace data before 
the trigger point is shown with negative times and trace data afterwards is positive as shown below. 

 
Figure 18:  Sample Trace Timescale with Trigger Point 

3.1.1 Simple Trigger 

By default a simple trigger has the same settings as no trigger as shown in the screenshot below.  

 

Figure 19:  Simple Trigger Configuration 
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A single stage of a trigger acts on either parallel or serial data controlled by the “Mode” dropdown list. 
Parallel mode means a single logic value on zero or more channels and serial mode means up to 32 bits 
of logic values on a single channel. The bit values are labeled from 0 to 31 on the trigger dialog and 
each bit has a “Mask” and “Value” checkbox. 

For parallel mode each bit value is a channel. A channel is enabled using the corresponding “Mask” 
checkbox and the “Value” checkbox is checked for a logical high; unchecked for a logical low. For 
example to trigger on a hex value of AA in channels 0 through 7, the trigger would be configured as 
below: 

 
Figure 20:  Example Parallel Mode Trigger 

For serial mode each bit value is for the same channel. The “Mask” checkbox indicates if a bit is 
significant and the “Value” checkbox signifies whether the given bit should be a high or a low. The 
“Channel” dropdown is now enabled to allow you to choose which the channel for the serial data 
trigger. Note that the time width for each bit value depends on the sampling clock and therefore it may 
take some experimentation to capture a precise bit pattern. 

For example suppose you wanted to trigger on the reception of the letter “R” in a logic level RS232 
transmission with parity where channel 0 is TX and channel 1 is RX. The 11-bit pattern for R including 
start and stop bits is: 

Start StopParityMSBLSB  
Figure 21:  Example RS232 Character 

The corresponding serial trigger channel 1 might be: 

 
Figure 22:  Example Serial Mode Trigger 

The “Arm” dropdown list and “Action” checkbox are only enabled for complex triggering and are 
described the next section. The “Delay” field is used to set the delay in samples between the trigger 
match and firing the trigger. 
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3.1.2 Complex Trigger 

A complex trigger is a multiple stages of a simple trigger with a control mechanism to determine the 
number of stages and when to proceed to the next stage. Selecting “Complex” from the “Type” field 
enables a complex trigger. 

The “Arm” dropdown list can be used for each stage to determine when each trigger is armed. This 
allows for example stage 0 and stage 1 to be armed immediately to look for different events at the same 
time and stage 2 is only armed when 1 has been triggered.  

 
The “Action” checkbox can be used to start a data capture at any trigger level. The combination of the 
“Arm” and “Action” fields allows for complex conditional triggers. 

3.2 Protocol Analysis 

The Java user interface can perform post-processing on the captured data to provide analysis of 
different data protocols. Currently two-wire serial (I2C) and three-wire serial (SPI) are supported. 

3.2.1 I2C 

The I2C analysis is available from the “Tools” menu and is shown in figure 25 on page 21. Note that 
the SDA and SCL channels are labeled as “A” and “B” respectively for the input area of the dialog but 
are correctly labeled further down. 

One way to capture data on the I2C bus is to look for a START request when the SDA line goes low 
while the SCL line is still high. Below is a screenshot of a simple trigger for the I2C protocol. 

 
Figure 23:  Example Trigger for I2C 
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Note that the before/after ratio is set to 25/75 because the I2C protocol analysis depends on the first 
SDA transition to mark a START request. A slightly better trigger which can be used after a power on 
and avoids false triggers is to use a second stage that looks for SDA to go high and SCL to go low thus 
marking the beginning of a I2C transfer. 

Below is an example screenshot for the data capture with SDA on channel 0 and SCL on channel 1 
using a 5 MHz sampling rate. 

 
Figure 24:  Example Data Capture for I2C 

It is possible with some effort to decipher the I2C protocol but the protocol analysis module makes it 
much easier. After selecting the channels for SDA and SCL, pressing the “Analyze” button results in a 
display as shown in the sample screenshot below. Note that after another data capture, the analysis area 
is not updated until the “Analyze” button is pressed again. 

 
Figure 25:  Example I2C Analysis 
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By using the various check boxes, the I2C START, STOP, ACK and NACK can be eliminated from 
the analysis screen after pressing the “Analyze” button again as shown in the screenshot below. 

 
Figure 26:  Example I2C Communication between Master and Slave 

This example of I2C protocol analysis was done with a microcontroller and the Devantech SRF08 
ultrasonic ranger. The ranger has a default I2C address of hex E0. After initializing the ranger, the 
microcontroller loops around requesting a range and retrieving the result over the I2C bus. As can be 
seen from the protocol analysis above, the microcontroller master writes to the SRF08 slave (E0) with 
a “read range high” request (2). The master then reads the word response (E1), which is the value 4; 
meaning 4 inches. The master then writes to slave (E0), a ranging request (0) in inches (80) and goes to 
sleep for 65 milliseconds to wait for the next ranging result.  

3.2.2 SPI 

The SPI analysis is available from the “Tools” menu and is shown in figure 28 on the next page. Figure 
27 shows an example data capture from reading an SPI EEPROM. The trigger was set to be a low to 
high transition on the CS (select) line shown as channel 3 below. Channel 0 is the SPI clock (SCK) 
which transitions for every bit transmitted.  

 
Figure 27:  Example Data Capture for SPI Protocol 
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For the SPI protocol it is important to correctly identify the MISO and MOSI channels, and to also 
know the mode, protocol, and bit order. The bit rate can be used to limit the sampling rate. For this 
example the bit rate for the example above is 7.3728 MHz and so the sampling rate is set to 50 MHz. 

The screenshot below shows an example analysis of the SPI protocol. At index 5, a sequence of bytes 
is read from the SPI EEPROM. This was verified against the expected result.  

 

Figure 28:  Example SPI Communication between Master and Slave 

3.3 Using the External Clock Input 

The logic analyzer can also use an external clock rather than the internal clock for sampling data. To 
use the external clock, it must be selected on the capture dialog by choosing the sampling clock to 
either be “External / Rising” or “External / Falling” as shown in the screen snapshot below. 

 
Figure 29:  Choosing the Sampling Clock 
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The omla32 interface card provides buffering and voltage conversion for two clock inputs labeled 
CLKo and CLKe. These inputs are brought out onto a 4 pin header near the B1 connector. To use 
either one of these clock inputs, it needs to be connected to the external clock input on the Spartan 3 
development board. This input is available on the A2 connector or on pin 5 of the auxiliary crystal 
socket. A valid external clock input is indicated by LD7 being lit. The picture below shows the hookup 
and LED. 

 
Figure 30:  Connecting an External Clock 

Below is the output for the previous I2C example (see section 3.2.1) but using an external clock 
instead of using a 5 MHz sampling rate from the internal clock. The clock was connected to the 
“XTAL2” input of an Atmel AVR with a 14.7456 MHz crystal. 

The data capture trace shown below has clock counts instead of time on the horizontal axis 
because the external clock frequency is unknown by the logic analyzer software. Similarly the 
I2C protocol analysis shows counts instead of seconds. 
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Figure 31:  Example Data Capture and IC2 Analysis using an External Clock 

3.4 Logic Analyzer ISE Project 

If you downloaded the logic analyzer files from the Oak Micros website then you can load the full 
project into the ISE 10.1 Project Navigator by using the Logic_Analyzer.ise project file. 

 
Figure 32:  Logic Analyzer Project in ISE 10.1 Project Navgiator  
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Select the la-Behavorial (la.vhd) source file in the left most window and then click on the plus sign on 
the “Configure Target Device”. Under that you will see the “Manage Configuration Project”.  

 
Double-clicking on this item starts the iMPACT tool, which displays both the PROM file formatter and 
boundary scan windows as shown below. Clicking on the boundary scan window allows you to 
download the logic analyzer into the serial PROM as described in 2.1.4 on page 9. 

 
Figure 33:  Using the iMPACT tool inside the Xilinx ISE Project Navigator 

If however you have the original source from the “sump” website then you need to change the la.ucf 
file to bypass an error message. Here are the 6 lines to add: 

 
134a135,140 
> # 
> # ISE 10.1 workaround on the next 2 lines - Mike Perks 10/26/2008 
> # 
> NET "exClock" CLOCK_DEDICATED_ROUTE = FALSE; 
> #PIN "Inst_core/BUFGMUX_intex.GCLKMUX.I1" CLOCK_D EDICATED_ROUTE = FALSE; 
> 

Help on using the ISE tool to rebuild the complete project is outside the scope of this document. 
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4 Getting Support 

Support for the omla32 interface card is provided by Oak Micros on a best effort basis through forums 
on our website (see http://oakmicros.com). You can also send an email to support@oakmicros.com.  
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Appendix A: Schematic for omla32 

For reference purposes the diagram below shows the schematic for the omla32 interface card. 

 

 
Figure 34:  omla32 Interface Card Schematic 

 


